Experiment:
Gases

I. INTRODUCTION

The primary objective of this experiment is to determine the relationship between the a) pressure
and volume and b) the pressure and temperature of a confined gas. Historically, the relationship
between pressure and volume was first established by Robert Boyle in 1662 and has since been
known as Boyle’s law. Nearly a century later, the connection between pressure and temperature
was established by Joseph Gay-Lussac and the relationship is called Gay-Lussac’s law. The
results from this experiment will allow you to rediscover the same mathematical relationships
described by Boyle and Gay-Lussac centuries ago.

Gases are made up of molecules that are in constant motion. Each collision of a gas molecule with
the walls of its container exerts a force on the surface. The force per unit area is the pressure of
the gas. Pressure measured with a mercury barometer is usually reported in millimeters of
mercury (mm Hg); a unit that is also called the torr. Another common unit of pressure is the
pascal (Pa) or kilopascal (kPa). The relationship of all these units of pressure to a standard
atmosphere (atm) is defined as

1 atm = 760 mm Hg = 760 torr = 101 kPa

Consider a gas confined inside a container. The velocity and the number of collisions of the gas
molecules affect the pressure of the gas inside the container. Any change that affects the velocity
and/or number of collisions of those gas molecules (such as a change in volume or a change in
temperature) will in turn result in a change in pressure. In order to establish the relationship
between a change in volume (Boyle’s Law) or a change in temperature (Gay-Lussac’s Law) and
the resulting change in pressure we need to review some mathematical relationships.

Two parameters can have a direct relationship (an increase in one parameter causes an increase in
the second parameter) or an inverse relationship (an increase in one parameter causes a decrease in
the second parameter). Furthermore, that relationship can be linear (a doubling of one parameter
causes a doubling of the second parameter) or non-linear (a doubling of one parameter causes a
change other than the doubling of the second parameter). One way to determine if a relationship is
direct or inverse is to find a proportionality constant (k) from your (x,y) data pairs. If the
relationship is direct and linear, then k=y/x. If it is inverse, so that the doubling of one parameter
results in the halving of the other, then k=x.y.



In this experiment you will determine whether a) the pressure and volume and b) the pressure and
temperature of a confined gas are directly or inversely related, and whether that relationship is
linear or non-linear.

Below are graphical examples of such relationships between sets of (X, y) data pairs:

Linear, Non-linear,
direct y direct
y
X X
Linear, Non-linear,
inverse y Yy inverse
X X

Linear relationships are easiest to work with. Some graphical manipulations allow many non-linear
relationships to be converted into a linear relationship. Consider the following:

e a non-linear relationship is often one in which y varies exponentially with x. That is, y might
vary with the square of x, the cube of x, etc. Such relationships become linear when you plot
(respectively) y versus x2, y versus x3, etc. For example:

becomes
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a non-linear, inverse relationship where doubling variable x reduces variable y in half becomes
a linear, direct relationship when you plot y vs. 1/x. You can also rationalize this backwards,
that is, a graph of y vs. 1/x that yields a straight line confirms an inverse relationship between
two variables, where doubling variable x reduces variable y in half.

becomes
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Il. LABORATORY BACKGROUND

A. The Effect of Volume on Pressure (Boyle’s Law)

In order to determine the relationship between the pressure and volume of a confined gas, you will
connect a syringe to a pressure sensor (Figure 1). The gas used will be air. It is assumed that the
amount (number of moles) of gas and the temperature of the gas inside the syringe will remain
constant throughout the experiment. When the volume of the syringe is changed by moving the
piston, there is a resulting change in the pressure exerted by the confined gas. This pressure change
will be monitored using a pressure sensor interfaced to a computer. Pressure and volume data pairs
will be collected during this experiment and then analyzed. From the data and graph, you should
be able to determine what kind of mathematical relationship exists between the pressure and
volume of the confined gas.
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Figure 1

B. The Effect of Temperature on Pressure (Gay-Lussac’s Law)

In this part of the experiment, you will study the relationship between the temperature of a gas
sample and the pressure it exerts. The gas sample (air) will be placed inside a sealed Erlenmeyer
flask, so that the amount (number of moles) of gas and the volume of the gas will be kept constant
throughout the experiment. Using the apparatus shown in Figure 2, you will place the Erlenmeyer
flask containing your air sample in water baths of varying temperature. Pressure will be monitored
with a pressure sensor and temperature will be monitored using a temperature probe. Pressure and
temperature data pairs will be collected during the experiment and then analyzed. From the data
and graph, you will determine what kind of mathematical relationship exists between the pressure
and absolute temperature of a confined gas.

Figure 2



I11. PRE-LAB QUESTIONS - Experiment: Gases

1. a) Complete the table below.

y X 1/x y/X Xy
2 2
1 4

0.5 8

0.25 16

b) On graph paper plot y vs. x (appropriately labeling all axes as well as graphing the best
fitting line/curve to the data points).

c) Is the relationship between the y and x data pairs linear or non-linear?
d) Is the relationship between the y and x data pairs direct or inverse?

e) Which expression of k (k=y/x or k=xy) corresponds to the relationship that you describe in
parts ¢ and d? (i.e. the expression where k is a constant)

2. a) Ploty vs. 1/x for the data in question 1.
b) Is the relationship linear or non-linear?

c) Is the relationship direct or inverse?

3. a) Complete the table below.

y X y/X Xy
2 4
4 8
8 16
16 32

b) On graph paper plot y vs. x (appropriately labeling all axes as well as graphing the best
fitting line/curve to the data points).

¢) Is the relationship between the y and x data pairs linear or non-linear?
d) Is the relationship between the y and x data pairs direct or inverse?

e) Which expression of k (k=y/x or k=xy) corresponds to the relationship that you describe in
parts ¢ and d? (i.e. the expression where k is a constant)



IVV. PROCEDURE

A. The Effect of Volume on Pressure (Boyle’s Law)

1. With the syringe disconnected from the gas pressure sensor, pull the plunger back to the 10.0
mL mark (until the front edge of the inside black ring is on the 10.0 mL mark, as indicated by
the arrow in Figure 3).
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Figure 3

2. Attach the 20 mL syringe to the gas pressure sensor.

3. Click to begin data collection.

4. Collect the pressure vs. volume data. It is best for one person to take care of the gas syringe
and for another to operate the computer.

* Move the piston to position the front edge of the inside black ring (see Fig. 3) at the 5.0-mL
line on the syringe. Hold the piston firmly in this position until the pressure value stabilizes.

* When the pressure reading has stabilized, click | ]. Type “5.0” for the volume.
5. Repeat the Step 4 procedure for volumes of 7.5, 10.0, 12.5, 15.0, 17.5, and 20.0 mL.

6. Click when you have finished collecting data. In your data table, record the pressure
and volume data pairs displayed in the Table window.

7. Examine the graph of pressure vs. volume (if needed to see all your data points, Autoscale
from the Analyze menu). Based on this graph, decide what kind of mathematical relationship
exists between these two variables (direct or inverse). To see if you made the right choice:

» Click the Curve Fit button

 Choose Variable Power (y = Ax™n) from the list at the lower left. Enter the power value, n, in
the Power edit box that represents the relationship shown in the graph (e.g., type “1” if direct,
“-1” if inverse). Click [Tf_1,



10.

11.

12.

* A best-fit curve will be displayed on the graph. If you made the correct choice, the curve
should match up well with the points. If the curve does not match up well, try a different
exponent and click again. When the curve has a good fit with the data points, click

oK.

Plot the pressure vs. volume graph manually using the graph paper provided. You can also
print your graph, if your instructor tells you to.

On your data sheet, calculate and record the reciprocal of volume (1/V), based on your original
volume data.

Plot pressure versus the reciprocal of volume (1/V) using the graph paper provided. Draw
the best-fit linear regression line for your data points. Note: to generate and print this graph
using your computer, follow the instructions listed in the EXTENSION section (see last page).

Calculate the values of P/V and PV, keeping in mind significant figures in rounding. Record
in your data sheet.

Answer the questions on part A of your data sheet.

The Effect of Temperature on Pressure (Gay-Lussac’s Law)

Prepare a boiling-water bath. Put about 800 mL of hot tap water into a I-L beaker and start
heating the water to a boil using the Bunsen burner.

Prepare an ice-water bath. Put about 700 mL of cold tap water into a second 1-L beaker and
add ice.

Put about 800 mL of room-temperature water into a third 1-L beaker.
Put about 800 mL of hot tap water into a fourth 1-L beaker.

An Erlenmeyer flask has been fitted with a rubber stopper that provides an airtight container
that allows you to investigate the gas (air) trapped inside. Make sure no air can go in or out of
the flask by closing the blue handle on the 2-hole stopper. Figure 4 shows the setup for your
experiment:
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Figure 4
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10.

11.

12.

13.

14.

15.

16.

Click to begin data collection.
Collect pressure vs. temperature data for your gas sample:

« Place the flask into the ice-water bath. Make sure the entire flask is covered with water (see
Figure 4).

* Place the temperature probe into the ice-water bath. Stir the water gently with the
temperature probe throughout the experiment.

» When the pressure and temperature readings displayed in the Meter window (bottom left of
screen) stabilize, click 1. You have now saved the first pressure-temperature data pair.

Repeat step 7 using the room-temperature bath.
Repeat step 7 using the hot-water bath.

Repeat step 7 using the boiling water bath. Use a utility clamp to clamp the flask inside the
boiling water bath. The temperature probe inside the water bath should not be touching the
bottom of the flask. CAUTION: Do not burn yourself or the probe wires with the Bunsen
burner flame.

Click when you have finished collecting data. Turn off the Bunsen burner. Record the
pressure and temperature values in your data table.

Examine the graph of pressure vs. temperature (°C). If needed to see all your data points,
Autoscale from the Analyze menu. In order to determine if the relationship between pressure
and temperature is direct or inverse, your temperatures must be converted to the Kelvin scale.
You can do this manually, or follow the instructions found in the EXTENSION section at the
end of this lab to see your results on-screen. Below are instructions for the manual calculations
and plotting.

Convert the Celsius temperatures into Kelvin temperatures by adding 273 to each Celsius
temperature. Record in your data sheet.

Plot pressure versus the temperature in Kelvin (K) using the graph paper provided. Draw
the best-fit linear regression line for your data points.

Calculate the values of P/T and P+ T (using your Kelvin temperatures for T). Record in your data
sheet, keeping in mind significant figures in rounding.

Answer the questions on part B of your data sheet.



DATA SHEET (pg. 1 of 2) Name

Experiment: Gases

A. Pressure vs. Volume (Boyle’s Law)

Volume Pressure v
mL [GE) (1/mL)

PROCESSING THE DATA

1. According to your data, if the volume is doubled from 5.0 mL to 10.0 mL, what
happens to the pressure? (Doubles? Triples? Halved/Reduced in half?)

2. According to your data, if the volume is halved from 20.0 mL to 10.0 mL, what
happens to the pressure?

3. According to your data, if the volume is tripled from 5.0 mL to 15.0 mL, what
happens to the pressure?

4. From your answers to the first three questions and the shape of the curve in the plot
of pressure versus volume, do you think the relationship between the pressure and
volume of a confined gas is direct or inverse?

5. Which expression of k (k=P/V or k=P+V) corresponds to the relationship between pressure and
volume? (Hint: the expression where the value of k is constant, or nearly so, from your data
table). This represents Boyle’s law.

6. Calculate the average value of k from your data. Record the correctly rounded value below.
Use that value of k and Boyle’s law (the expression you arrived at in question 5) to calculate
the new pressure if the volume of the syringe is increased to 40.0 mL.



B: Pressure vs. Temperature (Gay Lussac’s Law)

Pressure Temperature Temperature P/T PeT

Water Bath (Use TinK!)  (Use TinK!)

Ice

Room temperature

Hot

Boiling

PROCESSING THE DATA

1. In order to perform this experiment, what two experimental factors were kept constant?

2. Based on the data and graph that you obtained for this experiment, express in words the
relationship between gas pressure and temperature (K). (direct or inverse, linear or not).

3. Which expression of k (k=P/T or k=P+T) corresponds to the relationship between pressure and
temperature (K)? (Hint: the expression where the value of k is constant, or nearly so, from your
data table). This represents Gay-Lussac’s law.

4. According to this experiment, what should happen to the pressure of a gas if the Kelvin
temperature is doubled?

5. Calculate P/T for all the data pairs in your table, using T in Celsius. Does Gay-Lussac’s law
still hold true (is k still constant) if we use temperatures in Celsius?
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EXTENSION

Instructions to plot pressure versus the reciprocal of volume (1/V) using Logger Pro.

1.

Create a new column of data, reciprocal of volume, based on your original volume data.

* Remove the Curve Fit box from the graph by clicking on its upper-left corner.

+ Choose New Calculated Column from the Data menu.

» Enter “1/Volume” as the Name, “1/V” as the Short Name, and “1/mL” as the Unit. Enter the
correct formula for the column (1/volume) into the Equation box. To do this, type in “1” and
“/”. Then select “Volume” from the Variables list. In the Equation box, you should now see
displayed: 1/“Volume”. Click

* Click on the horizontal-axis label, select “1/Volume” to be displayed on the horizontal axis.

Click on the Linear Regression button, [. A best-fit linear regression line will be shown for
your data points. If the relationship between these data points (P and 1/V) is direct and linear,
the linear regression line should pass through (or near) your data points.

Instructions to plot pressure versus temperature (K) using Logger Pro.

1.

You can create a new data column for Kelvin temperature as follows:

+ Choose New Calculated Column from the Data menu.

* Enter “Temp (K)” as the Name, “T (K)” as the Short Name, and “K” as the Unit.

* Enter the correct formula for the column into the Equation box. Type in “273+”. Then select
“Temp Celsius” from the Variables list. In the Equation box, you should now see displayed:
273+“Temp Celsius”. Click [eore |

* Click on the horizontal-axis label, select “Temp (K)” to be displayed on the horizontal axis.

« If necessary, choose Autoscale from the Analyze drop-down menu.

Click on the Linear Regression button, <. A best-fit linear regression line will be shown for

your data points. If the relationship between these data points (P and T(K)) is direct and linear,
the linear regression line should pass through (or near) your data points.
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